CAREWare 6
June 2019

Quick Start Guide #7

Creating Basic Custom Reports

CAREWare Quick Start Guides will walk you through the basics of setting up, managing, and using the
main CAREWare functions. It is intended for non-technical users who need to get basic information in and
out of CAREWare.

PLEASE NOTE: The client data used in these manuals is purely fictional.
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First Things First

Getting Started

¢ You must have the appropriate user privileges to create and run reports.
e You should have enough client data entered to see how report filtering works in practice.

Best practices

Check if there are pre-built reports that provide the desired information. Decide what the
purpose of a custom report is. “I need a list of my clients with a break-out by race and gender,”
for instance.

Diagram your report by selecting the fields you'll need - in this case, client name, race, and
gender.

You may need to add fields, at least temporarily, that confirm your reports are running as
intended. For example, you create a filter for active clients only, so to make sure it's working,
you might add the “Enrollment status” field to your report. If the report runs correctly, and only
Active results return in that column, you can delete that field from the report, if not needed in the
results.

Demographic reports run differently than other reports:

e Demographic reports display results per client. This can be useful in determining the
number of clients in a given date span. With the use of calculated objects, demographic
reports can be a powerful tool for data analysis (see Quick Start guide 8 - Advanced
Reports).

o Other report types; such as services and labs display results ‘per service visit or lab date.’
This often results in several lines for each client, providing a detailed summary.

Creating Custom Reports

In addition to the prebuilt reports in CAREWare, you can use custom reports to view data sets
tailored to your needs. It helps if you have some familiarity with SQL databases before you use
custom reports, but if not, the report builder feature will help you design queries without prior
database experience.

1. Log into CAREWare. For more details on how to do so, please refer to the Navigating
CAREWare Version 6.0 Guide. If you have administrative privileges and are asked to
choose between Central Administration and Provider (“Default” until you change the name)
domain, you can log into either a Provider or the Central Administration domain. To run
reports for multiple agencies within a provider network, log in to the Central Administration
domain.
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2. Select Reports from the Main Menu.

@ Customize
Find Client

My Settings
System Information
System Messages

Administrative
Options

Switch Providers

Log Off

3. Select Custom Reports from the link menu.

CAREWare Reports

@CAREWare Reports

HRSA Reports RSR and ADR
Custom Reports ] Run or manage custom reports
Performance Measures Run or Manage Performance Measures
Client Data Reports Run reports on client information

Financial Report Setup and run the financial report
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4. Select Manage/Run Custom Reports from the link menu.

CAREWare Reports > Custom Reports
Back

@Custom Reports

Manage/Run Custom Reports Run or manage custom reports

Export Custom Reports Export custom report definitions to a portable xml file

Import Custom Reports from an
xml file

Import custom report definitions from a portable xml file

5. Select Add.

CAREWare Reports > Custom Reports > Manage Run Custom Reports
Manage Run Delete Make Read Only Back Help Print or Export

Manage/Run Custom Reports

Search: ‘

Name CrossTab Report Type Report Type Description
Death dates 01 Demographics dates of death
First Medical Service 01 Demographics 1st srvc

Sum of Services 01 Demographics add em up
Cap on charges Il 01 Demographics

Body Weights 01 Demographics weigh them.
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Enter in the following information (as applicable) and click Save.

e Report Name

o Report Type

¢ Is Crosstab (checkbox)

o Description (optional)

e Use Totals (checkbox — will automatically sum total fields in the report)

o Header/Footer Format (optional)

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Add

Save

Back

Add

Report Name: ‘Clients by Race and Gender

Setup Details

Report Type: ‘Demographics

Is Crosstab: [J

Description:

Use Totals: o

Header/Footer Format

Font Name: |Arial n
Bold: [
Italic: [

Underline: [J

Font Size:

Color: ‘BGCK
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7. After clicking save, you will be on the custom report’s menu. Select Field Selection.

CAREWare Reports » Custom Reports > Manage Run Custom Reports > Clients by Race and Gender
Back

@Clients by Race and Gender

Start Date : 03/27/2018, End Date : 03/27/2019, Clients with services, Report Display as :

(R o Open in New Window
Report Layout Clients by Race and Gender, Demographics
Field Selection No fields selected

Report Filter Report Filter is empty

8. Select Add.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection

Manage | Add | Move Up Move Down Delete Templates Back Print or Export

Field Selection

Search: |

Field Name Column Header Column Width (in) Totals Sort Sort Priority Status
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9. Use the Search box to find the fields to display in the report. In this example, “Name” was
entered. Since the complete client name is desired for the report, the Name field has been
selected. Click Use Field.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection > Add

Use Field| Back Print or Export

Report Fields

Search. Name

Field Name

Medications by indication
Current Regimen

First Name

Last Name

Last Service In Contract

Keywords

Demographics
Demographics
Demographics
Demographics

Demographics

Previous Field Name
Client Meds By Ind.
Current Regimen
First Name

Last Name

Last Service In Contract

Description
Returns full medication name for selected indication

Returns a list of ARV medications in a current regimen

Returns name of service category

Middle Name Demographics Middle Name
Name emographics Name
Physician name Demographics Phys. Name

Preferred Name (ClIn. Custom)

Preferred Name (CIn. Custom)

Culturally Sensitive Name requested by the client




Quick Start Guide #7 — Basic Custom Reports Page |7

10. You will now be on the Use Field menu. Enter in the following information (as applicable)
and click Save.

e Column Header

e Sort

o Sort Priority

Header Column Format

Data Column Format

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection > Add > Use Field

Back
Use Field

Select Field: |[Name

Column Header: |Name

Sort: |Ascending

Sort Priority: |1 |

Header Column Format

Column Width: |1.44 | inches

Column Header Font Name: |Aria|

Bold:
Italic:
Underline:

Font Size:

Font Color: |Black

I 0D oD o

Data Column Format
Font Name: |Aria|

Bold:

Italic:

Underline:

I 0O o

Font Size:

Font Color: |Black

Field Justification: |Left

<l )
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11. After clicking save, you will be on the selected field’s menu. Return to the Field Selection
menu by clicking Field Selection within the breadcrumb trail. Repeat steps 8 through 10 to
add additional Report Field selections (such as Race/Ethnicity and Gender).

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender 3 Field Selectionfp Name
Back

®Name

View Select Field Name; Demographics

12. To Return to the custom report’s menu, click the name of the custom report in the
breadcrumb trail (in this example, “Clients by Race and Gender”) or click Back from the
Field Selection menu.

CAREWare Reports > Custom Reports > Manage Run Custom Reports >} Clients by Race and Gender p Field Selection

Manage Add MoveUp Move Down Delete Templates IBackI Print or Export

Field Selection

Search:

Field Name Column Header Column Width (in) Totals Sort Sort Priority Status
Name Name 1.44 Group By 0 Complete
Race/Ethnicity Race/Ethnicity 1.44 Group By 0 Complete
Gender Gender 0.88 Group By 0 Complete

13. Click Run Report

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender
Back

@Clients by Race and Gender

Start Date : 03/27/2018, End Date : 03/27/2019, Clients with services, Report Display as :

Zugiizenor Open in New Window
Report Layout Clients by Race and Gender, Demographics
Field Selection No fields selected

Report Filter Report Filter is empty
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14. Click Edit. Select the following report parameters and click Save (will be visible after clicking
Edit).

o Date From
e Date Through
¢ Clinical Review Year (optional — typically matches the reporting year)
e Output Display
— Download as CSV
— Open in New Window
— Open as PDF

e Show New Client only (check box)

¢ Show Clients with Service only (check box — will only list clients with services within
date span)

e Show Specifications (check box — to list report criteria)
¢ Sum Numeric Fields (check box)
e Domain Sharing Settings (default value)

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Run Report
Run Report Back

Run Report

Parameters
Date From: |3/27/2018
Date Through: |3/27/2019
Clinical Review Year: |2019
Output Display: |Open in New Window
Show New Clients only:
Show Clients with Service only: ¥
Show Specifications:
Sum Numeric Fields:
Domain Sharing Settings
Show Shared Service Records:
Show Shared Clinical Records:
Show Shared Custom Subform Records:
Show Shared Case Notes:
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15. Click Run Report and then click View [name of report] (in this example, View Clients by
Race and Gender). The report will appear in a new tab within your browser.

Edit Back

Run Report

Date From:

Date Through:

Clinical Review Year:

Output Display:

Show New Clients only:

Show Clients with Service only:
Show Specifications:

Sum Numeric Fields:

Show Shared Service Records:
Show Shared Clinical Records:
Show Shared Custom Subform Records:

Show Shared Case Notes:

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Run Report
I Run Report

©)

e v

1112019 Report generation complete.
12/31/2019 :

2019 View Clients by Race and Gender

Open in New Window

Domain Sharing Settings

Clients by Race and Gender

Data Scope:
Report Start Date:
Report End Date:

Name:

Adap, Sigourney
Appleseed, Johnny
Appleseed, Martha
Badge, Jane
Badland, Abbey
Baker, Clam

Brown, Bustar

Ryan White AIDS Care and Treatment Clinic

01/01/2019

12/31/2019
Racel/Ethnicity: Gender:
Hispanic Female
Hispanic Male
Mot Specified Transgender MtF
Hispanic Female
Hispanic Female
Pacific Islander Male

Hispanic Transgender MtF
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Add Report Filters to “Clients by Race and Gender”

Use the Report Filter to choose how to sort your data. (It is a good idea to include Field
Selections that will verify your filters are working as intended.) For example: if you filter your
report for Females only, you would want to include the ‘Gender’ column among your Field
Selections in the report.

You can add a filter at the same time you create your field selections, before saving your report.
However, you may first want to run a report without filters to make sure you're getting data, and
then add the filters.

1. From the Manage/Run Custom Reports menu (see pages 2 through 3), use the Search box
to find the relevant report. We will be using the custom report: “Clients by Race and
Gender.” Select the report and click Manage Run.

CAREWare Reports > Custom Reports > Manage Run Custom Reports

Manage Run] Add Delete Make Read Only Back Help Print or Export

Manage/Run Custom Reports

Search:|Race and Gender

Name Description Report Type Date Created

Clients by Race and Gender Demographics 5/17/2019 7:54 AM

2. Click Report Filter.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender
Back

@Clients by Race and Gender

Start Date : 03/27/2018, End Date : 03/27/2019, Clients with services, Report Display as :

gunBenon Open in New Window
Report Layout Clients by Race and Gender, Demographics
Field Selection No fields selected

Report Filter Report Filter is empty
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3. Click Add.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Filter
Manage Move Up Move Down Delete Templates Back Print or Export

Report Filter

Search: ‘

Operator Paren. Field Name Is Not = >= <=

4. Enter “Gender” in the Search box to limit available Field Names. Chose the appropriate
Field Name and select Use Field.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Filter > Add

Back  Print or Export
Report Fields

Search: ‘Gender

Field Name Keywords Previous Field Name Description

ADR Gender ADR Gender

I Gender I Demographics Gender

5. Select Female from drop-down box. Click Save.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Filter > Add > Criterion Details

Save | Back

Use Field

Field Name: ‘Gender

Is Not:
I:: ‘Female I
Null: [

NOTE: The default value for Use Field is equal to “=". Checking the Is Not box will return
all values unlike the one selected. For example, if you selected Gender IS NOT Female,

the report would return Male, Transgender, Refused to Report, and Unknown values.
Checking the Null box would return any values where the Gender field was missing.
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Saving Filters as Templates

After selecting your filter field(s), you may also save this field selection as a template. Saving as
a template lets you apply the filter you've created to any report type.

1. From the Report Filter menu, select Templates.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Filter

Manage Add MoveUp Move Down Delete Back Print or Export
Report Filter

Search: \
Field Name Is Not = >= <= Null Status
Gender Female Complete

2. Select Save to New Template.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Filter > Filter Templates

Use Selected Template  Save To Selected Template | Save To New Template | Delete Back Print or Export

Filter Templates

Search: ir

Template Nam;
activeOnly

CD4 decline
MissingDempFilter
RsrDemographics1

RW funded

3. Enter the New Template Name and then click Save.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Filter > Filter Templates

Back

Save To New Template

New Template Name: |Females Only
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4. The filter template will appear on the Template Name list. In the future you can go to the
Templates window and select a template to use as a filter or set of filters. Just select the
filter and click Use Selected Template.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Filter > Filter Templates

I Use Selected Template I Save To Selected Template  Save To New Template Delete Back Print or Export

Filter Templates

Search: |

Template Nam;
activeOnly

CD4 decline
MissingDemPFilter
RsrDemographics1

RW funded

5. Select Back

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Filter
Manage Add MoveUp Move Down Delete Templates Print or Export

Report Filter

Search: ‘ ‘

Field Name Is Not = >= <= Null Status

Gender Female

Complete
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6. Click Run Report. Follow steps 14 and 15 on page 9-10.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender
Back

@Clients by Race and Gender

Start Date : 03/27/2018, End Date : 03/27/2019, Clients with services, Report Display as :

gun Bepor Open in New Window
Report Layout Clients by Race and Gender, Demographics
Field Selection No fields selected

Report Filter Report Filter is empty

Crosstab Reports

In the example above, we produced a report that listed each client separately. This is especially
helpful when you need a list in order to identify specific clients requiring follow up (e.g. needing
a vaccine, or who haven’t had an office visit for more than 3 months).

In addition, custom reports can be very useful in assessing data quality, for example, by listing
all the clients who have missing or out-of-range information for a certain field(s).

Crosstab Reports, however, allow you to quickly obtain the counts of clients for specific
criteria. For example, you may need to report the number of clients you are serving cross-
classified by race/ethnicity and gender, or by HIV status and CD4 group. The crosstab wizard
allows you to generate client counts.

Crosstabs have a row, column, and, if specified, a strata field. We will use the custom report
created in the previous step and change the report type to a Crosstab.
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1. From the Custom Reports menu, click Manage/Run Custom Reports.

CAREWare Reports > Custom Reports
Back

®Custom Reports

Manage/Run Custom Reports Run or manage custom reports

Export Custom Reports Export custom report definitions to a portable xml file

Import Custom Reports from an
xml file

Import custom report definitions from a portable xml file

2. Use the Search box to filter the existing custom reports. Select the report Name and click
Manage / Run.

CAREWare Reports > Custom Reports > Manage Run Custom Reports

Manage Run] Add Delete Make Read Only Back Help Print or Export

Manage/Run Custom Reports

Search: race

Name Description Report Type Date Created

Last CD4 by Race Demographics 7/16/2007 2:51 PM
Race*Gender Demographics 11/19/2007 3:34 PM
Race/ethnicity by Gender Demographics 9/1/2009 10:57 AM

|‘ Clients by Race and Gender Demographics 5/17/2019 7:54 AM
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3. Select Report Layout.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender
Back

@Clients by Race and Gender

Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Report Display as :

BagBsnod Open in New Window
Report Layout Clients by Race and Gender, Demographics
Field Selection Name, Race/Ethnicity, Gender

Report Filter Gender = Female

4. Select Edit (located where Save is in the screenshot below). Select the Is Crosstab
checkbox. Click Save.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Report Layout > Edit

Cancel
Edit

Layout Details

Report Name: |Clients by Race and Gender |

Report Type: |Demographics |

Is Crosstab: ¥

Description:
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5. After clicking save, click Field Selection from the menu.

CAREWare Reports » Custom Reports > Manage Run Custom Reports > Clients by Race and Gender
Back

@Clients by Race and Gender

Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Report Display as :

BRugiBEps: Open in New Window
Report Layout Clients by Race and Gender, Demographics, Crosstab
l Field Selection Name, Race/Ethnicity, Gender
Report Filter Gender = Female

6. Confirm the Field Names are correct. To remove a Field, select it and click Delete. In this
example, we are deleting the “Name” field.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection
Manage Add Move Up Move Down Templates Back Print or Export

Field Selection

Searr:h.'| |
Field Name Column Header Setup Status Field Status

I Name I Name Complete Row |
Race/Ethnicity Race/Ethnicity Complete Column

Gender Gender Complete Strata




Quick Start Guide #7 — Basic Custom Reports Page |19

7. Race/Ethnicity will be the Row and Gender will be the Column of the Crosstab Report. Click
Back.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection
Manage Add MoveUp Move Down Delete Templates Print or Export

Field Selection

Search: | |
Field Name Column Header Setup Status Field Status
Race/Ethnicity Race/Ethnicity Complete Row

Gender Gender Complete Column

8. Select Run Report.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and gender
Back

@Clients by Race and gender

B Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Report Display as :
Ul.hepo Open in New Window, Most medical services in date span

Report Layout Clients by Race and gender, Demographics, Crosstab

Field Selection Race, Gender

Report Filter Report Filter is empty
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9. A sample Crosstab report of Race/Ethnicity by Gender is provided below.
Clients by Race and Gender(Race/Ethnicity by Gender
Data Scope: Ryan White AIDS Care
Race/Ethnicity by Gender
Race/Ethnicity: Total: Col. %: Female: Male: Transgender Fth Transgender MtF:
Asian .1 8.0 1(16.7%) 5(83.3%) 1] o
E:,:‘:;:‘_Amm 20 26.7 11 (55.0%) 8(40.0%) 0 1(5.0%)
His panic 24 320 6(25.0%) 14(58.3%) 1(4.2%) 3(12.5%)
Morethan one race 5 6.7 1(20.0%) 3(60.0%) 0 1(20.0%)
Not Specified 3 40 ] 3(100.0%) 0 o
Pacific Islander 1 13 0 1(100.0%) 0 o
White (non-Hispanic) 16 21.3 5(31.3%) 11(68.8%) 0 ]
Total: 75 100.0 24(32.0%) 45(60.0%) 1(1.3%) 5(6.7%)

Number of Records: 8

e Total column: lists the number of clients by race.
e Col. % column: lists the percent distribution of clients by Race.

o Female, Male, Transgender FtM, and Transgender MtF columns: show the gender
distribution for each race category.

In the example above, Hispanic clients are 25% female and about 60% male clients, whereas
about 70% of white clients are male.

Crosstab Report (Adding a Strata field

To see the race and gender distribution of clients by HIV risk, you can add HIV Risk Factor as
a third Field Selection or Strata field.

1. From the Field Selection menu (see page 19), click Add.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection

Manage jAdd] Move Up Move Down Delete Templates Back Print or Export

Field Selection

Search:

Field Name Column Header Setup Status Field Status
Race/Ethnicity Race/Ethnicity Complete Row
Gender Gender Complete Column
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2. Use the Search box to find the desired Field Name. Choose the appropriate Field Name (in
this example we are adding HIV Risk Factor) and select Use Field.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection > Add
Use Field] Back Print or Export

Report Fields

Search: ‘hi\.r risk factor

Field Name Keywords Previous Field Name Description

Hemophiliac HIV risk factor Demographics Hemo Returns yes or no

Heterosexual HIV risk factor Demographics Hetero Returns yes or no

HIV Risk Factor Demographics HIV Risk Factor

Perinatal HIV transmission risk Demographics Peri Returns yes or no if client has perinatal HIV transmissi

3. Click Save, then Back.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection > Add > Use Field

Use Field

Select Field: |HIV Risk Factor

Column Header: |HIV Risk Factor

Total: |Group By

Sort: |

-l

Sort Priority:

4. Race/Ethnicity will be the Row, Gender will be the Column, and HIV Risk Factor will be the
Strata of the Crosstab Report. Click Back.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and Gender > Field Selection

Manage Add MoveUp Move Down Delete Templates |Back| Print or Export

Field Selection

Search: ‘ |
Field Name Column Header Setup Status Field Status
Race/Ethnicity Race/Ethnicity Complete Row

Gender Gender Complete Column

HIV Risk Factor HIV Risk Factor Complete Strata
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5. Select Run Report.

CAREWare Reports > Custom Reports > Manage Run Custom Reports > Clients by Race and gender
Back

@Clients by Race and gender

Start Date : 01/01/2019, End Date : 12/31/2019, Clients with services, Report Display as :

ke Open in New Window, Most medical services in date span
Report Layout Clients by Race and gender, Demographics, Crosstab
Field Selection Race, Gender, HIV Risk Factor

Report Filter Report Filter is empty

6. A sample (excerpt) Crosstab report of Race/Ethnicity by Gender and HIV Risk Factor is
provided below.

IDU
Race/Ethnicity: Total: Col. %: Female: Male: Transgender FtM: Transgender MtF:
Asian 2 138 0 2(100.0%) 0 0
Black or
rriemto e 3 176 3(100.0%) 0 0 0
Hispanic 5 294 1(20.0%) 3(60.0%) 0 1(20.0%)
Morethan one race 2 11.8 1(50.0%) 1(50.0%) ] 0
White (non-Hispanic) 5 294 1(20.0%) 4(80.0%) 0 0
Totat 17 100.0 6(35.3%) 10(58.8%) 0(0.0%) 1(5.9%)
Number of Records: 6
MSM
Race/Ethnicity: Total: Col. %: Female: Male: Transgender FtMt Transgender MtF:
Black or 5 387 0 5(100.0%) 0 0

African-Amencan

Hispanic 4 28.6 0 3(75.0%) 0 1(25.0%)
More than one race 1 71 0 1(100.0%) 0 0

Not Specified 1 71 0 1(100.0%) 0 0

White (nonHispanic) 3 21.4 0 3(100.0%) 0 0

Totak 14 100.0 0(0.0%) 13(92.9%) 0(0.0%) 1(7.1%)

Number of Records:
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